Welcome to Snow Leopard
How to get started

www.apple.com/support
Apple Inc.

© 2009 Apple Inc. All rights reserved. Apple, the Apple logo, Apple TV, Back to My Mac, Boot Camp, Cover Flow, Exposé, FireWire, iCal, iChat, iPhoto, iPod, iSight, Keynote, Leopard, Mac, Mac OS, MacBook Air, Photo Booth, QuickTime, Safari, Spaces, SuperDrive, Time Capsule, and Time Machine are trademarks of Apple Inc., registered in the U.S. and other countries. Aperture, Finder, iPhone, Snow Leopard, and Spotlight are trademarks of Apple Inc. AppleCare is a service mark of Apple Inc., registered in the U.S. and other countries. MobileMe is a service mark of Apple Inc. Other product and company names mentioned herein may be trademarks of their respective companies.

Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation.

Because Apple frequently releases new versions and updates to its software, images shown in this book may be different from what you see on your screen.

034-4970
Install Snow Leopard

To install Snow Leopard, insert your installation disk and double-click Install Mac OS X, then follow the onscreen instructions.

Click here to repair your startup disk or restore from a backup.

To restore your computer’s software, see the user guide that came with your computer.
Select installation options
When you’re ready, click Install to begin installing Mac OS X Snow Leopard. When the installation is finished, your computer will restart.

Click Customize if you want to change what’s installed.

For additional information, see the Instructions folder on your installation disc.
Meet Snow Leopard
Desktop
From the menu to the Dock, Snow Leopard looks great and helps you stay organized.
Stacks

The Dock includes the Documents, Downloads, and Applications stacks. Stacks provide a convenient way to get to documents and applications. To create a stack, drag a folder to the Dock.

When you click a stack, the items in it appear in a grid, fan, or list.
Downloads stack
Items you download in Safari, Mail, or iChat always go to the Downloads stack so that you can find them quickly.

The latest download appears here.

Click the Downloads stack to see items you’ve downloaded.
Customizing stacks

Stacks automatically appear as a fan or a grid, based on the number of items in the stack. You can specify which style you want to use and change the stack’s sort order.

To customize a stack, press the Control key and click the stack’s icon.
**Exposé**

Use Exposé from the Dock at any time to quickly view the windows open in an application and bring one to the front.

Click and hold the application icon to view open windows in Exposé.

To see a full-size preview of a window, highlight it and press the Space bar.
Finder
See full previews of your files in Cover Flow and flip through them quickly.
Cover Flow

Cover Flow lets you flip through your movies, presentations, PDF files, and more in large-size previews.

Click this button for Cover Flow.

Move the pointer over an item to play a movie or see the pages of a document, for example.

Drag the slider to flip through your documents.
Sidebar
The Finder sidebar makes it easy to get to folders on your computer, shared computers on your network, and your saved searches.

- **Shared computers** available on your network automatically appear here.

- **Commonly used searches** are included in the sidebar, and you can add your own searches.
Spotlight

In a Finder window or the menu bar, use Spotlight to search for items on your computer. If you use the same search often, save it in the Search For section of the sidebar.

Type your search here.

Click Save to add a Smart Folder to the sidebar.

See your search results in Cover Flow.
Shared computers

Shared computers on your network automatically appear in the sidebar so that you can quickly find documents they contain.

- Search for documents on shared computers.
- Get immediate access to the Public folder on any shared computer.
Screen sharing

Use screen sharing to get to the desktop of shared computers on your network. You can monitor use, change settings, and much more all from your computer.

Select the computer in the sidebar and then click Share Screen.

To use all of your screen, click the Full-Screen button.

To see the screen sharing toolbar, choose View > Show Toolbar from the menu.

You see the desktop of the other computer in a window.
Sharing

You can share your files, your website, your screen, and much more with other computers on your network. To start, open System Preferences and then click Sharing.

Click this Add (+) button to select any folder you want to share.

Click this Add (+) button to select users and groups who can share your files.
Back to My Mac

With your MobileMe subscription, an Internet connection, and Back to My Mac and sharing turned on, you can access any of your computers from anywhere on the Internet.

Back to My Mac computers appear in the sidebar.

Back to My Mac is on automatically.
Quick Look
See stunning previews of movies, PDF files, presentations, spreadsheets, and more without opening an application.
View documents

You can use Quick Look in the Finder, Time Machine, and Mail. To view an item in Quick Look, select it and then press the Space bar.

Click the Quick Look button in the Finder window toolbar.

Click here for a full-screen preview.
Browse contents
When you view documents in Quick Look, you can flip through each page of your document or view each slide of a Keynote presentation.
Show collections
You can use Quick Look to view several items at once. To automatically scan through the items, click the Play button.
Time Machine
Automatically back up your Mac. If you’re missing a document, travel back in time to recover it.
Turn on Time Machine

To start using Time Machine, just connect a FireWire or USB disk or a Time Capsule to your computer, and then click “Use as Backup Disk” in the dialog that appears.

When you turn on Time Machine, it backs up your computer to the disk you’ve selected.
Recover files

Easily find a missing document by seeing how your desktop looked in the past. Time Machine does a backup each hour of the current day, and then saves daily backups.

Type in the search field to look for a document.

Click the back arrow to go back in time.

Use Quick Look to check a document before you restore it.

Browse items in your backup using Cover Flow.

When you find the document, select it and then click Restore.
Set Time Machine preferences

To set Time Machine options, open Time Machine preferences. You can select a different backup disk or specify folders or disks you don’t want to include in your backups.

Click Options to select items you don’t want to back up.
Exchange

Mail, iCal, and Address Book support Microsoft Exchange to access your work email, calendars, and contacts.
Mail

To start using Exchange, just enter your Exchange email address and password, and Mail does the rest for you. Snow Leopard automatically sets up iCal and Address Book, too.

See your Exchange folders, notes, and tasks in Mail, and use smart mailboxes to locate special ones.

Use Spotlight to search your Exchange messages.

Accept calendar invitations in Mail.

Use Quick Look to preview attachments.
iCal

With iCal set up to access your Exchange server, you can accept and propose meetings with other Exchange users. You can also manage your tasks.

- Access your Exchange calendars alongside your personal calendars.
- Receive and respond to meeting invitations.
- Propose meetings, schedule conference rooms, and invite attendees from your Global Address List.
Address Book

Address Book gives you complete access to all your Exchange contacts, including your Global Address List.

Type here to search your Global Address List.

Update all the information about your Exchange contacts in Address Book.

Your Exchange contacts appear with your other Address Book contacts.
Safari

Safari redefines the browser, providing the most enjoyable way to experience the Internet.
Top sites
Safari identifies your favorite sites and displays them in a stunning preview that makes it easy to identify the sites you want to open.

Click here to view Top Sites.

To open a site, just click its preview.

A star indicates that a site has been updated recently.

Click here to customize Top Sites.
**Full history search**

Use full history search to flip through full page previews of webpages you have visited and easily find one even if you don’t remember the details of the site.

So you can see webpages the way they looked when you opened them, Safari stores the text and images of every page in your history for one month.

To search your history, click here and type a word or two.
Smart Address and Smart Search
As you enter web addresses and searches, Safari quickly finds the best results and provides other suggestions to help.

Safari offers excellent search suggestions, courtesy of Google Suggest and your recent search history.

Safari completes the address with the Top Hit and suggests others from your history and bookmarks.
iChat

Make your chats more fun using video effects such as backdrops. Show off your work with iChat Theater.
Video backdrops

Use video backdrops with your chats to “be” anywhere in the world. iChat includes movies and photos that you can use, and you can add your own.

Select a video backdrop and then step out of the picture for a moment.

Click Effects to select a video effect.

Add your own movies or photos to use as a video backdrop.
Effects
While you’re in a video chat, you can select video effects to make your chats fun and interesting.

Click any effect to use it.

Click the effect in the center for the original view.

Click any effect to use it.
iChat Theater

To show photos, movies, or presentations in a video chat, start the chat and then drag the file or files to the chat window.

See how your presentation looks to your buddy.

Control your presentation here.
iChat screen sharing
Screen sharing lets you take control of a buddy’s computer to show how to do something, rather than just explain it.

Click to switch screens. To copy a document to this computer, drag it here.

Select a buddy with video chat capability, and then click the Screen Sharing button.
Tabbed chats
Use tabbed chats if you have a lot of chats. To do so, open the Messages pane of iChat preferences, and then select “Collect chats into a single window.”

Click a chat to return to it.

See the latest reply from your buddy.
QuickTime X

QuickTime X debuts a new QuickTime Player with a simple design for viewing, trimming, and sharing your movies.
Simple Controls
QuickTime Player provides simple controls to play a movie. So your movie can take center stage, the controls fade from view.

To see the controls, just move the mouse pointer over the movie window.

Click here to watch your movie in full screen.

Click here to share your movie or to trim it.
Record video
Capture movies using QuickTime Player and the iSight camera built into your computer.

To record a movie, choose File > New Movie Recording, set up your shot, then click the record button.
Trim and share media

Trim your movie to just the part you want to use, then share it with iTunes to use on your iPhone, iPod, or Apple TV. You can also share your movie in a MobileMe Gallery or on YouTube.

Drag the ends of the trim area to select the part of the movie you want to keep.

Select the size appropriate for where you’ll view the movie.
Spaces
Organize your work and play by grouping application windows into a “space.” Then quickly switch between your spaces.
Arrange windows

Turn on spaces in Exposé & Spaces preferences, and then press Fn-F8 to show your spaces. To organize your windows, drag them from the current space to a different space.

Drag windows you want to use together into the same space.
Switch spaces
To switch between spaces, press Control + [an arrow key]. To go directly to a space, press Control + [a number key]. Arrange the order of spaces to suit your needs.
Customize spaces

After you turn on Spaces, you can add other spaces. You can also assign applications to each space so that the application’s windows always open in the same space.

Add rows and columns to create the spaces you need.

To assign an application, choose a space here or use the shortcut menu in the Dock.

Choose keyboard shortcuts that work best for you.

Click the Add (+) button to assign applications to spaces.
Mail

Use Apple-designed stationery to send gorgeous email messages complete with photos.
Stationery

When you create a message, select stationery to give it the perfect style whether the occasion is fun or formal. Including photos is easy using the Photo Browser.

Click to see the stationery you can use.

Select a type of stationery, and then click the stationery you want to use.

Select photos from iPhoto, Photo Booth, or Aperture.

Locate photos here, and then drag them to your message.
Notes and to-do items

Keep all your notes and to-do items in one place. Jot down reminders, shopping lists, and information you need. Include pictures, URLs, and attachments with your items.

Click to create a note or to-do item.

To create a to-do item, select text in the note and click To Do.

Click to set options for the to-do item. Items automatically appear in iCal.

See your notes and to-do items in the Reminders section of the sidebar.
Data detectors
You can turn dates in your email messages into iCal events. You can add names, phone numbers, and addresses to your contacts. You can even map addresses in Safari.

Move the pointer over the date, name, or address, and then click the triangle to choose an action.
Parental Controls
Give yourself peace of mind. Manage the time your children spend on the computer and what they do there.
Time limits
Manage when your children use the computer by setting time limits for weekdays, weekends, and nights.

Specify how many hours a day your child may use the computer.

Specify the hours during which your child may not use the computer on school nights and weekends.
Content limits
To limit the websites your children can visit on the Internet, click Content and then select the level of restrictions you want to apply.

Select this to try limiting access to adult websites. Click Customize to specify websites your children can and cannot visit.

Select which websites your children can visit.
Mail and iChat limits

Protect your children from unwanted communication by specifying who they can chat with and exchange email with.

Enter your email address to be notified if your children try to correspond with someone who isn’t in the list.

Click the Add (+) button to add an address.
Photo Booth

Discover more ways to have fun with new types of snapshots. Video backdrops add to the possibilities.
Video backdrops

“Be” anywhere in the world—or out of this world—by using backdrops when you take a snapshot.
4-up snapshots
Now you can make a burst of four snapshots. You can export a 4-up snapshot as an animated GIF to use as your buddy picture in iChat.

Click the 4-up button.

When previewing a 4-up snapshot, click a frame to preview that frame and select how to use it.
Movie clips
Make a movie of yourself using effects and backdrops. Use your movie as a video greeting, complete with audio, to send to your friends in an email message.

Click the Movie Clip button.

When you preview a movie, move the pointer over the image to control playback.
Boot Camp

To use a Windows application on your Mac, install Boot Camp and your copy of Windows. Then you’re ready to go.
Install Boot Camp

Open Boot Camp Assistant (in the Utilities folder in the Applications folder) and print the *Boot Camp Installation & Setup Guide*. Then create a partition for Windows.

If you installed a beta version of Boot Camp, you only need to install the new Windows drivers by switching to Windows and inserting the Snow Leopard installation disc.
Install Windows

Insert your Windows XP or Windows Vista installation disc and click Start Installation.

To install Windows software on a MacBook Air, you need an external optical drive such as a MacBook Air SuperDrive.
Switch systems

In Mac OS X, open Startup Disk preferences to select your Windows partition. In Windows, open the Boot Camp Control Panel and then click Startup Disk.

Select your Windows partition and then click Restart.

Select your Mac OS X startup disk and then click Restart.
Here if you need us

www.apple.com/support
Learning more, service, and support

Online resources
For online service and support information, visit www.apple.com/support. Choose your country from the pop-up menu. You can search for the latest software updates and manuals, find answers using the AppleCare Knowledge Base, or get help from Apple’s discussion forums.

Onscreen help
You can find answers to your questions, as well as instructions and problem-solving information, by using the Help menu in some applications. Choose Mac Help from the Finder Help menu, type a few words in the search field, and then press Return.

System Profiler
Use System Profiler to retrieve information about your computer. System Profiler indicates the hardware and software installed on your computer, the serial number and operating system version, the amount of memory installed, and how much battery power remains. To open System Profiler, choose Apple () > About This Mac from the menu bar, and then click the More Info button.
AppleCare service and support information

Your Mac OS X product comes with 90 days of complimentary telephone support.

AppleCare telephone support representatives can help you solve basic problems. Contact the support center nearest you, or visit www.apple.com/support/expert to arrange a phone call with an Apple Expert who specializes in your exact question (not available in all countries). Have the date of purchase and your Apple computer serial number ready when you speak to a representative.

Note: Telephone fees may apply. For more information, visit www.apple.com/support/complimentary.

You can extend your coverage by purchasing the AppleCare Protection Plan. For more information, visit www.apple.com/support/products.

For additional information about contacting Apple Support, visit www.apple.com/contact/phone_contacts.html. (Telephone numbers are subject to change.)

<table>
<thead>
<tr>
<th>Technical Support Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States</td>
</tr>
<tr>
<td>Canada</td>
</tr>
<tr>
<td>Australia</td>
</tr>
<tr>
<td>New Zealand</td>
</tr>
<tr>
<td>United Kingdom</td>
</tr>
<tr>
<td>Ireland</td>
</tr>
</tbody>
</table>